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Understanding Bentley i-model (.icm.dgn) Files 

Like Bentley i-models (.i.dgn) before them, i-model (.icm.dgn) files are containers for the open 

exchange of infrastructure information. Bentley’s i-model technology is used to write an 

Infrastructure Consensus Model (ICM) file that contains civil engineering objects. This new i-

model (.icm.dgn) functionality is available in these Bentley civil design products with OpenRoads 

SELECTSeries 3 technology (SS3):  

 InRoads 

 MXROAD 

 GEOPAK (SS3; Maintenance Release 2 (MR2)) 

In these programs, you can create an i-model (.icm.dgn) file that can contain these civil objects: 

 Points 

 Linear entities 3D (3D polylines) 

 Horizontal alignments (3D lines that may or may not be associated with a corridor) 

 Profiles 

 Station equations 

 Meshes 

 Surface meshes (on page 25) (open meshes) 

 Component meshes (on page 23) (closed meshes) 

 Corridor Meshes (meshes that are associated with a corridor) 

 Surface meshes (on page 25) 

 Corridor top mesh (on page 23) 

 Corridor bottom mesh (on page 23) 

 Corridor default surface mesh 

 Terrain models (typically original/existing ground, but possibly site designs). 

 DTM/TIN models (can include islands, voids, and holes) 

 Boundaries and breaklines (can be soft or hard) 

 Corridor alternate surfaces (not to be confused with meshes) 

Note: Templates may include information on alternate surfaces. These can be generated by 

the Create Corridor Alternate Surfaces command in the Terrain Model section of Civil Tools. 

While these surfaces are terrain models (TIN surfaces), they are alignment-based and, 

therefore, are exported with design model information in the i-model (.icm.dgn), as opposed 

to the Terrain Model group. 
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 Corridors 

 Master alignment 

 Top and bottom surface alignments  

 Boundary/hull 

 Attribute information 

 Names 

 Levels (layers) 

 Colors 

 Line styles (defaults) - These are based on the standard 8 line styles available in all 

Bentley civil products; custom styles are not supported. Each line style name is prefixed 

with "i-model". Line style scale information is not included in the i-model (.icm.dgn) file, 

so a value of 1.0 is used. 

i-model ( . icm.dgn) Fi les in Relat ion to i-model ( .dgn) Files  

While similar technology is used to create i-model (.icm.dgn) files, the previously released i-

model functionality is not specifically related to i-model (.icm.dgn) files. The Publish i-model 

command in various Bentley products will not produce an i-model (.icm.dgn) file; the Create i-

model (.icm.dgn) command must be used. i-model (.icm.dgn) files use newer i-model technology 

that is not compatible with any of the publicly available Bentley i-model readers. Currently, 

Business Center - HCE is the only released product that can read i-model (.icm.dgn) files. Existing 

i-model (.i.dgn) files are not importable into this program. 

Related topics 

 Bentley-Trimble i-model (.icm.dgn) Workflow (on page 2) 
 

Bentley-Trimble i-model (.icm.dgn) Workflow 

The goal of this Bentley-Trimble workflow is to guide you through an enhanced connection 

between the virtual and physical environments for infrastructure and construction site projects. 

When design and engineering teams use Bentley ProjectWise and Business Center - HCE to link 

design offices to construction sites, designers and contractors can collaborate more effectively 

on constructible models. This integrated and managed workflow enables more efficient bidding 

and estimating, faster project approvals, reduced change orders, and shortened construction 

timelines. 

Bentley’s V8i (SELECT Series 3) civil engineering software generates i-model (.icm.dgn) files from 

detailed designs. These designs, when managed in Bentley ProjectWise, can then be easily 

imported into Business Center - HCE for construction preparation and management. To optimize 

construction management processes and maximize information transfer, Trimble® Connected 

Site® technology can then be used to send these designs wirelessly to machines and field 

systems on a construction site, thereby increasing productivity and reducing data exchange 

problems (where data was lost or could not be read directly by contractor's tools).  



 3 

   

Key components of the workflow include: 

 Bentley ProjectWise - ProjectWise is a system of project collaboration servers and services 

that provides an environment for work-sharing, content re-use, and dynamic feedback 

for the design and construction of architecture, engineering, construction, and 

operations (AECO) of infrastructure projects. 

 Bentley i-model (.icm.dgn) Files - Infrastructure Construction Models (ICMs) provide a 

rich data exchange format for Bentley civil design products based on the OpenRoads 

SELECTSeries 3 (SS3) platform, facilitating the exchange of both CAD information (layers, 

colors, line styles, names, etc.) and civil design objects (alignments, surfaces, corridors, 

meshes, linework, points, etc.) within a single transfer mechanism. 

Business Center - HCE - Features that support i-model (.icm.dgn) files in this program include: 

 i-model (.icm.dgn) importer - This importer enables the import and the intelligent reading 

of an i-model (.icm.dgn) files contents, along with accurate mapping of civil design 

objects to constructible objects that can be readily moved out to Trimble field systems 

using standard field data management tools. 

 External services connection to ProjectWise - This feature allows you to set up ProjectWise 

as an external service, including the ProjectWise server name, your user name, and 

password, which can then be used in the commands below: 

 Open Remote File - This command allows you to open i-model (.icm.dgn) files, as well as 

native VCE project files, from ProjectWise servers. You can also locate, retrieve, and 

import other file types from the ProjectWise servers, including PDF, DXF, DWG, DGN, 

LandXML, CSV, TXT, GENIO and other supported file formats.  

 Save File Remotely - This command enables you to save native VCE projects to the 

ProjectWise servers, allowing Business Center - HCEto join the software ecosystem 

deployed by the contractor or engineer on the ProjectWise server. This information 

sharing with the ProjectWise community allows for the passing of RFIs or as-built records 

back to the original engineer or owner upon completion of construction processes. You 

can also export directly to an external service using the Export command. 
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Workflow 

1. Prepare your data in a Bentley civil product with OpenRoads technology (InRoads, MXROAD, 

or GEOPAK that has been upgraded to SELECT series3 MR2): 

Note: These first steps are not intended to replace Bentley documentation on preparing 

your design data to create an i-model (.icm.dgn). Please see the help for your specific 

Bentley civil product. The steps should be similar in the Bentley civil products mentioned 

above. 

a. Create the existing terrain and/or infrastructure design data that you want to send to 

the field via Business Center - HCE. 

b. Ensure that the objects you want to export to the i-model (.icm.dgn) are civil objects 

(on page 22): 

Select File > Project Explorer. Click the Civil Model tab and expand groups to see 

which object are included in the civil model. 

c. Set an appropriate Design Stage (on page 23) for each corridor section you want to 

include in the ICM: 

On the Civil Model tab in the Project Explorer, expand the groups under a civil object 

that contains a corridor. Under Corridors, identify a corridor section that should be 

assigned a design stage. Select Tools > Selection > Element Selection, and graphically 

pick the corridor section. Select Element > Information. In the Corridor section of the 

Element Information pane, select a design stage. 

d. If needed, specify to include a corridor and/or component meshes in the i-model 

(.icm.dgn): 

In the Project Explorer, click the Civil Standards tab. Expand the groups under the civil 

object that contains the corridor, and then expand Project Settings and Corridor 

Design Stages. Select a design stage. In the Element Information pane under Output 

Settings, set Create Top Mesh and/or Create Bottom Mesh to True. Edit any other 

output settings, as needed. 

e. Process the objects for the i-model (.icm.dgn): 

Click the Civil Model tab in the Project Explorer, right-click the parent civil design 

objects that you want to include, and select Process All Objects. Processing can also 

be done on individual civil objects using the Process Corridor command. 

2. Create and save the i-model (.icm.dgn) to ProjectWise: 

a. Once all of the civil objects have been processed, select Tools > Tasks. Expand 

Corridor Modeling, and click the Create i-model (.icm.dgn) icon . 

b. Check the boxes for Design Model and/or Terrain Model, and click Ok. 

 Include Design Models - Select this to export horizontal and vertical geometry, including 

station equations, corridor models, and civil cells (blocks) along with their resulting 

geometry and surfaces meshes (including alternative surfaces, where created). 
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Note: Existing corridor data produced prior to SS3 MR2 requires reprocessing to ensure that 

required corridor data (denoting top and bottom features and top and bottom meshes) is 

included.  

Note: Area templates that are common in civil cells may require turning on linear features to 

generate the required geometry associated with the surfaces. 

 Include Terrain Models - Select this to export all terrain data stored in the current and 

referenced models. Native MicroStation graphics are not automatically included in the i-

model (.icm.dgn) exchange. However, if they are promoted into the civil model by 

applying a civil feature definition, then they are included as geometry in the i-model 

(.icm.dgn). 

Tip: Since terrain models can be large, consider separating the Design Model and Terrain 

Model into two separate i-model (.icm.dgn)s. 

a. In the Create i-model (.icm.dgn) file dialog, add a name, confirm the .i-model 

(.icm.dgn).dgn file extension, and click Save. 

b. When the program finishes creating the i-model (.icm.dgn) repository, open 

ProjectWise Explorer and upload/save it to ProjectWise.  

Note: By default the i-model (.icm.dgn) will be called <filename>.i-model (.icm.dgn).dgn. 

You cannot rename the file to *.i.dgn or *.dgn and successfully read the file using i-model 

readers nor DGN readers. 

Note: i-model (.icm.dgn)s cannot be created by the Publish i-Model command. 

3. In Business Center - HCE, configure External Services (on page 7) with a ProjectWise 

username and password. 

4. Open/import (on page 6) the i-model (.icm.dgn) from ProjectWise to a local folder using the 

Open Remote File (on page 9) command. If you have an i-model (.icm.dgn) file outside of 

ProjectWise, you can simply import (on page 10) it into Business Center - HCE. For details on 

how i-model (.icm.dgn) data is handled using either method, see Import Bentley i-model 

(.icm.dgn) Files (on page 10). 

5. Explore the various objects that were created on import and the layers they reside on to 

confirm that the model has been formed as expected. 

6. Create and/or edit additional objects (points, surfaces, alignments, corridors, etc.) as needed. 

7. Run takeoff and mass haul calculations and reports.  

8. Visualize your project in various views (Profile, Cross-section, 3D, 3D Drive, Walk-Through). 

9. Prepare field data for use by construction crews on the job site. This data might include site 

data, design data, and work orders to be used on SCS site controllers and site and design 

data to be used on GCS machines.  

Using site controllers, you can then measure material volumes, monitor grades and laid 

material thickness, and perform other site-related tasks, such as point, line, roadway, and 

surface stakeout. With machines, you can perform scraping, grading, excavation, and 

compaction activities with accurate guidance, and blade and bucket positioning.  
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10. Make the data available to field workers on the Connected Site via the Connected 

Community. 

11. Import measured and as-built results from the field back into Business Center - HCE. 

12. Export (on page 19) data files or save (on page 20) your Business Center - HCE project back 

to ProjectWise so engineers and other stakeholders can review the construction project's 

status and make design changes.  

Related topics 

 Open and Save Files from/to Bentley ProjectWise (on page 6) 

 
 

Open and Save Files from/to Bentley ProjectWise 

After you have used the External Services command (on page 7) to set up your account 

information for Bentley ProjectWise, use the Open Remote File command (on page 9) to 

download i-model (.icm.dgn) files (as well as PDF, DXF, DWG, DGN, GENIO files) from 

ProjectWise. This data can then be prepared for use by survey and construction crews on a job 

site, creating an integrated workflow for the engineering and then construction of roads and 

sites.  

Use the Export and/or Save File Remotely (on page 20) commands to save files projects and data 

files back to ProjectWise. This workflow will help you share civil design data for Bentley InRoads, 

MXROAD, and GEOPAK between ProjectWise and Business Center - HCE while preserving data 

fidelity. You can export/upload any supported format that creates a single file, i.e. ESRI shape 

files and Geodatabase XML files are not supported. 

Note: Business Center - HCE allows you to establish multiple "External Services", as well as 

multiple user profile for each service. Each account connects to a different instance of a service, 

e.g., Connected Community or ProjectWise. If your ProjectWise instance connects automatically 

to datasources provided by your project partners, but shows up in your ProjectWise instance as 

a locked datasource (which would require an additional login to your partner ProjectWise 

instance), Business Center - HCE requires that you set each ProjectWise connection as a separate 

External Service. You cannot carry out a second login from within an external service.  

Prerequisites :  

 Bentley ProjectWise account  

To access the commands:  

 Select Options > External Services. 

 Select Open Remote File. 

 Select Save File Remotely or Export. 

Related topics 

 Import Bentley i-model (.icm.dgn) Files (on page 10) 



 7 

   

 
 

Log In to External Services 

The Enter Login Information dialog displays when you attempt to access an external service (such 

as the Connected Community, InSphere Market Place, or Bentley ProjectWise (on page 21)) without 

completing all of the required user profile fields for the service in External Service Options (on 

page 7). 

To log in to an external service:  

 In the Enter Login Information dialog, complete the required fields and click OK.  

As long as Business Center - HCE remains open, you do not have to re-enter the login 

information each time you access the external service.  

Related topics 

 Open a Remote File (on page 9) 

 Save a File Remotely (on page 20) 
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External Service Options 

Use the Options dialog to set up user profiles for logging in to external services, such as the 

Connected Community, InSphere MarketPlace, Bentley ProjectWise (on page 21), and other web 

sites/services that work with this software. For additional information on getting an account with 

an external service, contact your dealer. Using the New button, you can create multiple user 

profiles with their own user names and passwords for any external service. 

To specify external services options:  

1. Select Options. 

2. Under General in the left pane, click External Services. 

3. Click New to create a profile. 

Note: Business Center - HCE allows you to establish multiple "External Services", as well as 

multiple user profile for each service. Each account connects to a different instance of a 

service, e.g., Connected Community or ProjectWise. If your ProjectWise instance connects 

automatically to datasources provided by your project partners, but shows up in your 

ProjectWise instance as a locked datasource (which would require an additional login to your 

partner ProjectWise instance), Business Center - HCE requires that you set each ProjectWise 

connection as a separate External Service. You cannot carry out a second login from within 

an external service.  

4. In the Service list, select the service that you want to access. 

5. Enter your name or the name of the profile, and click OK. 

6. In the Service profiles list, select the profile you created. 

7. Enter the Server, User name, and Password you received from the external service provider in 

the required fields. 

Note: The options will vary depending on the external service selected. If you do not 

complete the required fields, you will be prompted to enter profile (login) information when 

you select to use an external service. 

Note: If there are no options available in the Service list, contact your dealer to learn more 

about external services. 

8. Click Test Connection to verify you are able to connect to the selected service. 

9. When you are done, click OK. Now, when you connect to external services using Open 

Remote File, Save File Remotely, Export and other commands, the information you set up for 

your accountprofile will automatically populate the needed fields. 

Related topics 

 Log In External Services (on page 7) 

 Open a Remote File (on page 9) 

 Save a File Remotely (on page 20) 

 Download and Upload Files to/from Bentley ProjectWise (on page 6) 
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Open/Import a Remote File 

Remote files are those that are stored in folders hosted by external services, such as the 

Connected Community (TCC) and Bentley ProjectWise (on page 21). You can open a remote 

project or import a remote data file directly into your current project. 

Note: When you open a remote project from an external service, only the .vce file is opened; 

supporting files that are usually stored in the project's subfolder are not available.  

You can also check out a remote file so that no one else can change and save it over the original 

file. When you check out a file, an  icon appears next to the name, indicating that it is locked. 

A copy of the locked file is created; the file name is appended with (Working Copy). The working 

copy can be modified and saved to the remote location by anyone, but the original, locked 

version can only be overwritten by the person who checked the file out (using their working 

copy).  

Note: File locking/check out is supported in ProjectWise, but not from within Business Center - 

HCE. In this program, you can see which files are locked, open them, and resave them with the 

same name. The most recent/newest file overwrites any other file of the same name, but there is 

file versioning. 

For additional details, see Maintain Project Files Remotely. 

Note: Some external services, including TCC, require that you set up a user profile before you 

can access them through this command. To set up a user profile for services, see External Service 

Options (on page 7). 

To open/import a remote project:  

1. Select Open Remote File. 

The Open Remote File dialog displays, showing a list of the folders, projects, and files that are 

accessible to you. 

Note: The paths displayed depend on the permissions you have been granted by the 

administrator of the external service. For access to other locations, contact your 

administrator. 

2. Double-click folders to navigate to the project or files you need. To navigate up in the folder 

structure, double-click the folder named "...". 

3. Double-click a project to open it, or data files to import them. Remote projects that you 

open are automatically saved to your local project folder. Data from remote files that you 

import is added to your current project. 

Note: If you import a remote file, the settings specified in the Import command pane for that 

file type will apply to the import. Therefore, you may want to confirm those settings before 

you import each type of file. 

Note: For information on how specific types of files import, see the help topic on importing 

the file format (on page 19). 
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To check a remote fi le out or in:  

 Right-click the file in the Open Remote File dialog, and select Check Out or Check In from the 

context menu. 

Related topics 

 External Service Options (on page 7) 

 Save a File Remotely (on page 20) 

 Save a File Remotely (on page 20) 
 

Import Bentley i-model (.icm.dgn) Files 

Import Bentley i-model (.icm.dgn) files to bring Infrastructure Concensus Models (ICMs) 

containing civil engineering objects into your project. For more information, see Understanding 

Bentley i-model (.icm.dgn) Files (on page 1). 

Note: This topic refers only to the newer i-model (.icm.dgn) versions of i-models, not the older 

i-model (.i.dgn) file format. 

Note: Although i-model (.icm.dgn) files are intended to contain civil objects, it is possible to 

have a combination of civil and non-civil objects in the file. Importing non-civil objects is not 

recommended. 

Importable Data  

Here is a simplified view of how the civil objects (and their names) are mapped when they are 

imported from a Bentley civil product into Business Center - HCE via an i-model: 

Note: The i-model (.icm.dgn)'s contents and the import settings you choose determine which 

objects are imported, and whether alignments that that are not associated with a corridor are 

imported as linework (on page 25). 
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Bentley Civil  

Object  

 

 i-model 

(.icm.dgn) 

Object  

 Business Center - 

HCE 

Notes 

 

Point > Point > Point Points can be either 2D or 3D. 

3D Linear Element 

> 

Linear Entity 3D 

> 

2D or 3D polyline, arc, circle, 

spline, linestring (depending 

on what the original object 

was) 

The original line styles are preserved, but all 

line style scales are set to 1.0.  

Note: Vertical arcs in 3D linear elements are 

not supported in linestrings; a straight line is 

drawn between the start and end points of 

the vertical arcs. Tilting of the plane of 

horizontal arcs is handled consistently.  

Note: For line styles, the Project Setting > 

View > Display Options > Show all lines 

as solid is honored. Other settings that 

affect line styles include Project Settings > 

View >Plan View > Plot Scale, and 

Properties> Linetype Scale. 

Complex Element 

> 

Alignment 

> 

Alignment Line, Bspline, spiral (clothoid), and arc 

segments in the horizontal plane are 

supported. 

Alignments with profiles that are not 

associated with a corridor can be imported 

as either alignments and profiles or as 

linestrings. See Import Options below. 

Profiles 

> 

Profiles 

> 

Profiles Line, arc, and parabola (symmetrical) 

segments are supported. 

Profiles are expected to be associated with 

an alignment, and an alignment can have 

multiple associated profiles. 

Active Profile 
> 

Active Profile 
> 

Active Profile Only one profile can be set as the active 

profile for the alignment. 

3D Linear 

Element 

(chorded) 

> 

3D Linear 

Element 

(chorded) 

> 

These are not supported. 

 

 

Station 

Equations 
> 

Station 

Equations 
> 

Station Equations  

Mesh > Mesh >   

Mesh Surface 

(no depth) > 

Surface Mesh 

> 

Surface (TIN) Surface meshes do not generate linework 

and corridor surface meshes are not 

imported if corridor linework is present. 

Mesh 

Component 

(with a volume) > 

Component 

Mesh 

> 

Linestrings The importer creates a closed linework 

polygon to represent each face of a 

component mesh. These faces are then 

shaded according to the imported mesh 

color. 
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Mesh with a 

corridor 

relationship 

> 

Corridor Mesh 

> 

  

Mesh Surface 

(no depth) 
> 

Surface Mesh 
> 

Surface (TIN)  

Mesh 

Component 

(with a volume) > 

Component 

Mesh 

> 

Linestrings The importer creates a closed linework 

polygon to represent each face of a 

component mesh. These faces are then 

shaded according to the imported mesh 

color. 

Terrain Model > Terrain Model > Surface (TIN)  

Hull/Boundary > Boundaries > Boundaries  

Breaklines 

> 

Breaklines 

> 

Breaklines Hole, island, and void boundaries are 

imported as breaklines.  

Contours and soft breaklines are imported 

with soft surface sharpness. Other breaklines 

import with sharp or sharp and texture 

boundary surface sharpness. 

The distinction between a void and a hole is 

only apparent when surfaces are merged. A 

void persists after the surfaces are merged, 

even if the other surface contains triangles 

over that area. A hole is filled in if the surface 

being merged contains triangles for that 

area. 

Corridor > Corridor > Corridor  

Corridor 

Baseline 
> 

Corridor 

Baseline 
> 

Alignment (main)  

Hull/Boundary > Hull/Boundary > Boundary  

ID of 

Top/Bottom 

Elements 

> 

ID of 

Top/Bottom 

Elements 

> 

Breaklines to form top 

and bottom surface 

 

Non-importable Data 

Data that is not included in the i-model (icm.dgn) format includes: 

 Non-civil objects (e.g., native MicroStation objects) 

 Corridor templates 

 Superelevation tables 

 Coordinate systems  
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To import an i-model ( . icm.dgn) f i le:  

 Follow the instructions in Import Data. 

Import Options 

Data to import  All - Select this to import every object in the file, whether it is a 

civil or non-civil object. 

 Civil Objects Only - Select this to import every object that is not 

a component mesh.  

 Component Meshes Only - Select this to import only the 

component meshes in the file.  

Import non-corridor 

alignments as 

 Alignments - Select this to import all alignments that are not 

associated with a corridor as alignments. 

Note: Alignments cannot be converted to linestrings after 

import,but alignments can be created from linestrings; either can be 

included in a surface. 

 Linework - Select this to import all alignments that are not 

associated with a corridor as linestrings. 

Note: See the Imported Non-corridor Alignments table (next) for 

the effect of these options on different types of linear objects. 
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Create the corridor’s 

top surface from 

 Linestrings - Select this to use corridor sub-alignment strings 

(alignments and/or linear entities 3D) to form the corridor 

surface. 

Forming a corridor from linestrings has these advantages: 

 The corridor is suitable for densification (although this is not 

turned on by default) 

 The corridor includes the sub-alignment names 

And this disadvantage: 

 When two corridors intersect each other, the linestrings get 

clipped but the boundary does not. The surface formation in this 

area can be poor. 

Tip: Both surface representations benefit from frequent 

template drop settings to increase the fidelity of the data 

written to the i-model (.icm.dgn) and consequently 

Business Center - HCE. See the Design Stage (on page 23) 

topic for more information. 

 Surface Mesh – Select this to use the top surface mesh, if 

present in the file, to form the corridor surface. 

Forming a corridor from surface meshes has this advantage: 

  The clipping problem between corridors is resolved 

And these disadvantages: 

 They are not suitable for densification 

 Sub-alignment names are not available 

 Surface formation over non-planar mesh faces may not be what 

was intended  

Note: See the Corridor's Top Surface Formation table (two below) 

for the effect of these options on top surface formation. 

Tip: You may find that the Surface Mesh option creates a better 

corridor top surface for GCS900, but that the Linestrings option 

creates a better surface for SCS900. Depending on the road 

geometry, the triangulation you get from linestrings may be 

unexpected, although not necessarily incorrect. Experiment with the 

options to see which provides the optimal results for your needs. 
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Imported Non-corridor Alignments  

Here are the effects of the Import non-corridor alignments as option on linear objects: 

Object in the 

File 

Resulting Object in Business Center - HCE 

 When Imported as an Alignment When Imported as a Linestring 

Alignment 

Line Line Line 

Arc Arc Arc 

Spiral Spiral Chords* 

BSpline Chords Chords** 

Profile 

Line Line Line 

Arc Arc Line 

Parabola Parabola Parabola 

*The chording setting (determining the amount of deviation) is specified in Project Settings > 

Computations > Surface > Breakline Approximation Parameters > Horizontal Tolerance. 

**When imported as linestrings, alignment Bsplines are chorded because the importer first 

interprets the alignment as a Business Center - HCE alignment and then converts the alignment 

into a linestring. 

Top Surface Formation for a Corridor  

An i-model (.icm.dgn) may contain multiple representations of a corridor, including: 

 Sub-alignments of the corridor stored as alignments (with profiles) and/or linestrings (Linear 

Entity 3D) 

 A surface mesh of the entire top surface (Surface Mesh) 

 Individual meshes that can be merged to form the corridor surface; these may or may not 

correspond to the top surface 
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Two factors determine how the corridor’s surface is formed: 

 The contents of the i-model (.icm.dgn) file 

 The Create the corridor’s top surface from import setting: 

 Linestrings - The importer’s default is to use the Linestrings option if alignments and/or 

linear entities 3D are present in the file. If the preferred surface formation data is not 

present, the importer will revert to the next best option and trigger import report 

warnings to advise you that your preferred option was not available (see Import Report 

Warnings below). If the corridor’s top surface is created from linestrings, the top surface 

mesh and individual corridor meshes for that corridor (if present) are not imported. If the 

top and/or bottom corridor surfaces have been constructed from linestrings, the names 

will be: <Corridor name> - Top Surface and <Corridor name> - Bottom Surface for the top 

surface and bottom surface, respectively. 

 Surface Mesh - If the corridor’s top surface is created from the top surface mesh, then the 

individual corridor meshes for that corridor (if present) are not imported. If the corridor’s 

top surface is created from a top mesh, the name will be <corridor name>.default or 

<corridor name>.Top Mesh, depending on the Top Mesh Feature Definition defined in the 

selected design stage. 

Regardless of how the corridor’s top surface is formed, a corridor’s linestrings are imported. 

Corridor surface meshes are not imported if the corridor linework is present. 

In the absence of top surface information, it is better to have a corridor surface than no surface, 

so an Individual Corridor Surface Meshes option (fourth column) is used as the last choice used in 

forming the corridor surface. While the surface that the individual surfaces represent is valid, 

there is no indication as to which corridor surface they reflect. To prevent many small surfaces 

being created in your project, the importer collates the individual corridor surface meshes into 

one surface on import.  
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Here are the possible effects of the Create the corridor’s top surface from option on the imported 

top surface (with the defaults in green): 

Import Option 

for Top 

Corridor 

Surface 

Formation 

Contents of the i-model (.icm.dgn) Warning in 

the Import 

Report  
Top Surface 

from  

Linestrings 

Top Surface 

from Surface 

Mesh 

Top Surface from 

Individual 

Corridor Surface 

Meshes 

Linestrings — — — None 

Linestrings  — — 1 

Linestrings   — 1,3 

Linestrings    1,3 

Surface Mesh — — — None 

Surface Mesh —  — 2 

Surface Mesh   — 2,3 

Surface Mesh    2,3 

Import Report warnings:  

1. Corridor '{0}' doesn't have top surface linework 

2. Corridor '{0}' doesn't have a top mesh surface 

3. Corridor '{0}' doesn't have a top surface definition 

Bottom Corr idor Surface Representation  

An i-model (.icm.dgn) can also contain a mesh representing the entire bottom corridor surface. 

This mesh encompasses the extents of the corridor, which generally means that it joins the top 

corridor surface. However, the routine that forms the bottom surface selects the next offset out 

from the edge bottom subgrade point to connect to; this may or may not reflect the intention of 

the original design. For example, the subgrade may connect to the top surface with a vertical, or 

even over-vertical, face. When this occurs, the importer takes a conservative approach and forms 

an alignment surface from the bottom only sub-alignment strings; no connection to the top 

surface is made.   
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Figure: Cross-section (using Surface Slicer View) of imported corridor top and bottom surfaces  

(to simplify the view, labels have been hidden for the bottom surface) 

Layer Creation and Entity Values  

The i-model (.icm.dgn) importer creates layers in Business Center - HCE that correspond to the 

Bentley levels used by the objects in the i-model. When importing terrain models, the importer 

creates two layers for each surface: 

 <surface name>_Breaklines - This contains the associated breaklines, contours, and soft 

breaklines for the surface. These are automatically associated with and used in the surface 

formation. 

 <surface name>_Boundaries - This contains the boundary, holes, islands, and voids 

associated with the surface. These objects are automatically added to the surface as closed 

breaklines, as they are in Bentley products. 

Holes, Is lands, and Voids in Surfaces  

Both Bentley civil products and Business Center - HCE handle holes and islands in the same way. 

An island must be enclosed by a hole. Holes and islands cannot overlap. Void boundaries in 

Bentley products are treated as holes in Business Center - HCE. 

Component Mesh Handling 

Component meshes are not natively supported in Business Center - HCE. Component meshes 

can, however, be imported using a Data to import option: 
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 Separately, by selecting Component Meshes Only 

 Along with the rest of the civil data, by selecting All.  

Component meshes are not imported when the Civil Objects Only is selected.The i-model 

(.icm.dgn) importer creates a closed linework polygon to represent each face of the component 

mesh. These faces are then shaded according to the imported mesh's color.  

Scenarios:  

 If you import the same i-model (.icm.dgn) file more than once, the first imported model does 

not get updated by changes in the second; you simply have both models in your project. All 

the data is imported from i-model (.icm.dgn) model into the Business Center - HCE project. 

The i-model (.icm.dgn) importer does not provide options to update or overwrite existing 

data in the project; so you may end up with duplicates of data in the project, depending on 

the import settings when you reimport data from an i-model (.icm.dgn) into the same 

project. Each import, however, does create a separate selection set (and thereby view filter) 

which enables you to hide either set of data. 

Dependencies:  

 None 

Related topics 

 Open and Save Files from/to Bentley ProjectWise (on page 6) 

 
 

 

Export Data 

Export data from your project in a variety of formats. See the individual file format topics for 

details. You can also save your project or data files to an external service (on page 7) using the 

Save File Remotely (on page 20) command. 

To export data:  

1. Do one of the following:  

 Select Export. 

 Select one or more points, right-click, and select Export from the context menu. 

The Export command pane displays. 

2. Click an export type (Custom, Survey, GIS, CAD, or Construction) in the File Format group. A list of 

available exporters displays. 

3. Select an export format (on page 20) in the list. If one with the desired format is not listed, 

create a custom exporter. 

Caution: If you have a field device connected, only file types compatible with the device 

appear. 
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4. If needed, use the View Filter Manager command to filter the selectable data in the plan 

view. 

5. Select the data to export using one of the Selection Options. 

6. Choose where to save the exported file: 

 Select a local or network folder in the File Name list, or click the  icon to browse for a 

folder.  

 Click the  icon to save the file remotely to an external service. For information on 

setting up an external service, see External Service Options (on page 7). 

When you click the  icon, the Save As dialog displays with the export folder specified in 

Options > File Location selected. However, you can browse to and select a different folder. 

7. Type a new file name in the File Name box if you do not want to overwrite an existing file. 

8. If export settings appear in the Settings group, specify them as needed. 

9. Click OK to export the data. 

Tip: You can select data before you begin the Export command. 

Tip: To customize the format of the exported data, select Export Format Editor. 

Related topics 

 Export Data Formats (on page 20) 

Save a File Remotely (on page 20) 
 

 

Save a File Remotely 

Make projects available to your colleagues by saving them to a shared folder hosted by an 

external service, such as the Connected Community (TCC) or Bentley ProjectWise (on page 21). 

When you save a file remotely, you are essentially making a copy of the file that is saved locally. 

Before you can save a file to an external service, you should set up a user profile (on page 7) for 

your external service. 

Note: When you save a project remotely to an external service, only the .vce file is saved; 

supporting files that are usually stored in the project's subfolder are not saved with the project. 

Note: You can also launch the Save File Remotely command from within the Export command. 

Exporters that write multiple files cannot be used to export to external services; external services 

only support exporters that save a single file. 

For additional details, see Maintain Project Files Remotely. 

To save a f i le remotely:  

1. Save your file so that it will be copied in its current state when you save it remotely. 

2. Select Save File Remotely. 

3. In the External service profile list, select your user profile. 

4. Double-click folders to navigate to the location in which you want to save the file. 
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5. Click Save. The file is saved remotely with the same name as the local file. 

Related topics 

 External Service Options (on page 7) 

 Open a Remote File (on page 9) 

 Open a Remote File (on page 9) 
 

Bentley ProjectWise 

ProjectWise is a Bentley system of project collaboration servers and services for AECO 

information management for the design and construction of architecture, engineering, 

construction, and operations (AECO) of infrastructure projects. ProjectWise provides an 

environment for work-sharing, content re-use, and dynamic feedback. 
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Glossary items  

alignment 

A line used to denote the path of a corridor (roadway, trench, channel). 

See also Horizontal Alignment (HAL) and Vertical Alignment (VAL). 

Note: In some Bentley civil products (such as InRoads) an alignment can be a linear object that 

has no association with a corridor. 

civil  feature definit ion 

Feature definitions, like the former legacy style files are fundamental to Bentley civil users for the 

display of objects and standardization of designs. 

Feature definitions: 

 Include properties used to define how a feature is to be displayed, annotated, computed, 

etc. 

 Can be applied to these three object types: 

 Point feature 

 Linear feature 

 Surface feature 

 Are typically customized by each organization/company  

 Expected to be created in advance and used to drive standardisation of designs across 

an organisation 

 Replace legacy Bentley style files of these types: 

 XIN (InRoads) 

 DDB, XML (GEOPAK) 

 PSS (MXROAD) 
 

civil  model 

In Bentley civil software, an infrastructure model composed of civil objects (on page 22). 

civil  object 

In Bentley civil software, civil objects are points, lines, alignments, surfaces, meshes, corridors, 

etc. that were created by Civil Tools in Bentley software or they have been promoted into the 

civil model by applying a civil feature definition. Native MicroStation objects can be ‘promoted’ 

to a civil model by assigning civil features to them. Feature definitions, like the former legacy 

style files, are fundamental to Bentley civil users for the display of objects and standardization of 

designs. 
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component mesh 

In Bentley civil products, a shaded, 'closed' 3D shape (mesh) that encompasses a volume. 

Typically, component meshes, which represent objects such as guardrails, subgrade materials, 

bridge components, piles, etc. are imported from i-model or IFC files. 
 

corridor top mesh 

In Bentley civil software, a surface mesh of objects tagged in a corridor template as being part of 

the top surface of the corridor. A corridor top mesh is used to form the corridor top surface in 

Business Center - HCE when an i-model (.icm.dgn) file is imported. 

corridor bottom mesh 

In Bentley civil software, a surface mesh of objects tagged in a corridor template as being part of 

the bottom surface of the corridor. A corridor bottom mesh is used to form the corridor bottom 

surface in Business Center - HCE when an i-model (.icm.dgn) file is imported. 

design stage 

In Bentley civil products, corridor design stages have a significant impact on the type and 

accuracy of data exported in an i-model (.icm.dgn) from Bentley civil products. Design stages 

and associated settings are typically part of a company’s libraries, and vary depending on the 

standards the company wishes to use. Individual DGN files will only contain the stages (and 

feature definitions) used in their particular project. Each corridor in a DGN file may have an 

independent design stage setting. You should confirm that the design stage setting reflects your 

data requirements in the i-model (.icm.dgn) and in Business Center - HCE. 

The aspects that a design stage impacts include: 

 The template drop interval multiplier - When templates have a drop interval defined, this 

property determines whether the interval or some multiple of the interval is used. 

 Which critical cross-sections are used 

 What data is outut: 

 Corridor top mesh (on page 23) 

 Corridor bottom mesh (on page 23) 

 Linear features 

 Corridor sub-alignments (on page 26) 

 Component meshes (on page 23) 

The template drops, template drop interval, template drop interval multiplier, and which critical 

points are used drive the density of the meshes, stroking (on page 25) of some chorded sub-

alignments, and chorded linework representations of horizontal alignments. In the later case, 

where there is a horizontal alignment with geometry and a chorded approximation of it, the i-

model (.icm.dgn) importer will ignore the chorded approximation. 
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Default Design Stages and Some of their Default Properties  

 

0
 -

 F
u

n
c

t
io

n
a

l 

1
 -

 P
r
e

li
m

in
a

r
y

 

2
 -

 D
e

s
ig

n
 

3
 -

 F
in

a
l 

4
 –

 F
in

a
l 

w
/
 M

e
s
h

e
s

 

5
 –

 F
in

a
l 

T
o

p
 M

e
s
h

 

6
 –

 F
in

a
l 

B
o

t
t
o

m
 

M
e

s
h

 

7
 –

 F
in

a
l 

L
in

e
a

r
 

F
e

a
t
u

r
e

s
 

8
 –

 F
in

a
l 

C
o

m
p

o
n

e
n

t
s
 

Template Drop 

Interval 

Multiplier 10 5 2 1 1 1 1 1 1 

Hz. Cardinal 

Points False True True True True True True True True 

Vt. Cardinal 

Points False True True True True True True True True 

Ext. Cardinal 

Points False True True True True True True True True 

Densify Hz. 

Curves False True True True True True True True True 

Densify Vt. 

Curves False True True True True True True True True 

Create Top 

Mesh False False False False True True False False False 

Create Linear 

Feature True True True True True False False True False 

Create Comp. 

Mesh True True True True True False False False True 

Design stages properties can be edited and new design stages can be created. This is set on the 

individual components that are used to build up the templates. Their properties contain an 

Exclude From Top/Bottom Mesh check box. Once all the components are used to form the 

corridor model, Bentley will determine the top most points and the bottom most points to 

create the top and bottom meshes from. 
 

hull 

In Bentley civil software, a surface boundary. 
 

i-model (i .dgn) 

A container (file format) for the open exchange of infrastructure information. 
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i-model (. icm.dgn) 

A container (file format) for the open exchange of infrastructure information (like Bentley i-

model (.i.dgn) before it). Bentley’s i-model technology is used to write an i-model (.icm.dgn) 

(Infrastructure Consensus Model) file that contains civil engineering objects (points, lines, 

alignments, surface and component meshes, corridors, terrain models, and attribute 

information). The i-model (.icm.dgn) functionality is available in these Bentley civil design 

products with OpenRoads SELECTSeries 3 technology (SS3): InRoads, MXROAD, GEOPAK (SS3; 

Maintenance Release 2 (MR2)). 

level 

See layer or material layer. 

(Bentley MicroStation uses "level" for layer.)  
 

l inework 

Data with various types of lines (polylines, linestrings, arcs, circles etc.). 

sample rate/interval/sampling distance 

Generically, the interval in time or distance at which samples are taken. Specifically, sample 

intervals in this software are used to: 

 Generate cross-section templates (at a distance interval) along a horizontal alignment during 

the creation of a corridor. 

 Download GNSS raw data from a CORS station or a base station (using a time interval equal 

to or shorter than the interval in your project). If the station has used a collection interval 

higher than the occupations in your project, the download process will decimate (reduce the 

station data) down to the level you set. 

Note: In Bentley civil products, the sampling interval is called the "template drop interval". 

surface mesh 

In Bentley civil products, an 'open' mesh that does not encompass a volume, which equates to a 

surface in this software. Unlike in Business Center - HCE, this imported surface type supports 

vertical and over-vertical faces. The surface mesh components are typically comprised of 

straight, four-sided quads. They may, however, contain three-sided triangles or faces that are 

comprised of five or more straight sides. The faces are typically planar, but non-planar mesh 

faces are also permitted.  

stroking and densifying 

Concepts/terms used in Bentley civil software that control how often to generate points or 

template drops along various linear objects, such as alignments. 
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corridor sub-alignment 

In Bentley civil software, secondary linework (may or may not be an alignment) that does not 

denote a corridor's centerline alignment. 

terrain model 

A surface; a conventional TIN model that does not contain vertical nor over-vertical faces. 
 




